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摘摘要要

本应用报告介绍 作为 Bluetooth®低耗能“外围”器件运行的 CC2650、CC2640 和 CC2640R2F 器件的设置及

功耗测量程序。

可以从以下 URL 找到应用报告中讨论的“功耗计算工具”：www.ti.com/ble-power-calculator。
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1 简简介介

蓝牙低耗能标准在开发过程中就考虑到了长电池寿命，可支持器件依靠单节纽扣电池运行数年。我们假定本

应用报告的读者对 BLE 标准以及德州仪器 (TI) 的 SimpleLink™蓝牙低耗能 CC2640 和 CC2640R2F 无线微

控制器 (MCU)（附带软件开发套件 BLE-Stack）有一定了解。

此外，我们还假定读者对基本的电气功能概念有所了解，并了解如何使用振荡器和直流电源等实验室测试设

备。

本文针对一个示例应用提供了功耗测量并计算了电池寿命。还随附了功耗计算工具，以便您可以根据您自己

的定制使用方案估算电池寿命。

请注意，本文档中提供的结果旨在提供指导。各种各样的因素都将影响蓝牙低耗能产品的电池寿命。您应针

对目标应用方案在受控环境中于硬件上执行测量。

另请注意，本应用报告中提供的波形和功耗测量结果可能不全都与最新的软件优化保持同步。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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1.1 首首字字母母缩缩写写词词

表表 1. 本本文文档档中中使使用用的的首首字字母母缩缩写写词词

首首字字母母缩缩写写词词 说说明明

CM3 Cortex-M3
CPU 中央处理单元

DC 直流

DK 开发套件

DUT 待测试的器件

EM 评估模块

GAP 通用访问配置文件

GPIO 通用输入/输出

MCU 微控制器单元

PC 个人计算机

RF 射频

RISC 精简指令集计算机

RTC 实时时钟

RTOS 实时操作系统

RX 接收

SCA 睡眠晶体精度

TX 发送

2 了了解解蓝蓝牙牙低低耗耗能能指指标标

蓝牙低耗能器件通过使无线电活动时间保持短暂并允许器件在大多数运行时间处于待机或断电模式来实现低

功耗。

蓝牙低耗能器件会在一定的时间内处于特定的模式（例如当通告或保持连接时），从这种意义上讲，其运行

通常是静态的。这些模式基于能够用于轻松估算平均功耗的重复发生事件。其中的每个模式均可根据增加的

数据吞吐量或降低的延迟（例如通过更高的连接间隔）来进行量化，转化为可供将来估算之用的状态。

主要的衡量指标是通告和已连接模式的平均电流。这些值可用于确定蓝牙低耗能器件的电池寿命。

对于无线 MCU，如 CC2650，我们必须明白该器件通常不仅运行蓝牙低耗能协议堆栈，而且还运行配置文

件服务和一个应用。该应用可能还使用芯片上的外设，如 SPI 或 ADC。此外，除了运行蓝牙低耗能协议堆

栈的器件，电路板上的其他器件也可能消耗电流。

蓝牙低耗能应用有三个主要的组成部分，它们加在一起构成了平均功耗：待机、协议事件和应用事件。这些

组成部分将消耗不同量的功率，具体取决于蓝牙低耗能器件的用例。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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图 1 基于连接的蓝牙低耗能器件的电流消耗测量数据。该器件的大部分时间处于待机模式，此时的平均电流

消耗大约为 1µA。

图图 1. BLE 连连接接期期间间的的电电流流消消耗耗与与时时间间

器件仅根据外部中断或来自 RTC 的预定事件/中断从待机模式唤醒。待机还包含再充电，节 5.3.2对此进行

了更详细的介绍。

在协议事件期间，通过蓝牙低耗能协议进行通信。对于蓝牙低耗能器件，这些事件可能是通告事件或连接事

件。允许蓝牙低耗能器件进入 Observer 角色并进行扫描的角色有多个，但本应用报告中没有介绍这些角

色。

应用事件是特定于应用的实现，例如，周期性事件、串行通信或根据传感器输入运行算法。根据活动量，应

用事件可能会显著地增加功耗，因此应始终致力于优化处理用法。应用事件通常在相邻协议事件之间发生，

这意味着较长的通告或连接间隔将为处理提供较长的时间段。

3 SimpleLink 蓝蓝牙牙低低耗耗能能无无线线 MCU

德州仪器 (TI) 提供了多种蓝牙低耗能解决方案。从只是简单的广播设备到采用多角色实时操作系统 (RTOS)
的高级解决方案，应有尽有，如表 2 所示。

(1) 针对尺寸和功耗对单端射频模式进行了优化。在 CC2650EM-4XS 上测得。

表表 2. 德德州州仪仪器器 (TI) 提提供供的的蓝蓝牙牙低低耗耗能能解解决决方方案案

CC2540 CC2540T CC2541 CC2541-Q1 CC2543 CC2544 CC2640
最大输出功率 +4dBm +4dBm 0dBm 0dBm +5dBm +4dBm +5dBm
TX 电流
(0dBm)

26mA 26mA 18.2mA 18.2mA 26mA 27mA 6.1mA (1)

尺寸 (QFN) 6x6 6x6 6x6 6x6 5x5 5x5 4x4、、5x5、、7x7
BLE-Stack 支持 是 是 是 是 仅广播 仅广播 是是

USB 2.0 是 是 - - - 是 -
主要 特性 USB 高温<125°C I2C + 较低功耗 通过汽车认证 低成本 低成本 + USB RTOS + 最最低低功功

耗耗

本应用报告侧重于 CC2640、CC2640R2F 及其超集器件 CC2650。

CC2640/CC2640R2F 是可以在单个芯片上提供完整解决方案的蓝牙低耗能无线 MCU。它运行三个内核，可

以单独对这些内核进行供电和控制。应用处理器是 ARM® Cortex®-M3，它用于运行蓝牙低耗能配置文件以

及任何用户定义的功能。应用和蓝牙低耗能协议堆栈的一部分共享 20kB 的 RAM 以及高达 128kB 的闪存。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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图图 2. CC26xx 架架构构概概图图

射频内核可确保正确配置和处理与蓝牙低耗能协议相关的所有计时。ARM Cortex-M0 专用于无线电操作，

从其自己的专用 ROM 运行 BLE 无线电固件。

传感器控制器包含一个小型的专有 RISC CPU，该 CPU 旨在减轻 Cortex-M3 的负载。当系统的其余部分处

于待机模式时，它能够以低功耗方式运行小型算法或者与传感器通信。它可能在发生中断时唤醒并执行一些

简单的处理，然后根据传感器输入唤醒 CM3。

外设和串行域包含丰富的用于串行通信的外设模块以及通用 IO 和计时器。

CC2650 具有两个电源供电级别，如表 3 所示。要启用 1.8V 系统，需要对硬件和软件进行修改，

《CC13xx、CC26xx SimpleLink™ 无线 MCU 技术参考手册》 [2]对此进行了说明。

表表 3. CC2650 电电源源电电压压

电电源源电电压压 内内部部直直流流/直直流流 最最小小值值 最最大大值值

1.8V 系统（外部稳压器模式） 否 1.7V 1.95V
3.3V 系统 可选 1.80V 3.80V

有关 CC2640、CC2640R2F 和 CC2650 的更多信息，请分别参阅 CC2640 [3]、CC2640R2F [4] 和
CC2650 数据手册 [5]。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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4 功功率率测测量量设设置置 – 准准备备 DUT

对于待测试的器件 (DUT)，必须先从硬件和软件角度做好准备，然后才能执行测量和分析。而且还可能需要

为其配置对等器件，以便建立连接。在本应用报告中，我们使用运行示例项目 HostTest 的器件来建立连

接。可用来运行该项目的器件有 CC2650/CC2640R2 LaunchPad、CC2650EM 或 CC2540 USB 软件狗。

图图 3. 待待测测试试的的器器件件

4.1 要要求求

要测量蓝牙低耗能的平均功耗，需要使用德州仪器 (TI) 提供的以下硬件：

• CC2650EM 和 SmartRF06EB

或

• CC2650/CC2640R2 LaunchPad

以及

• 运行 HostTest 项目的器件（例如，CC2650/CC2640R2 LaunchPad、安装在 SmartRF06EB 上的

CC2650EM 或 CC2540 USB 软件狗）- 可选

CC2650EM 和 SmartRF06EB 包含在可以在 TI store [6] 购买的 CC2650DK 中。也可以在 TI store 购买

CC2650/CC2640R2 LaunchPad (LP)。请注意 CC2650 和 CC2640 之间的差异。CC2650DK 和

CC2650LP 包含 CC2650 多平台 MCU 评估模块。CC2650 是超集器件，支持包括蓝牙低耗能在内的多种协

议，并且仅处理蓝牙低耗能应用时可以与 CC2640 互换。因此，对于蓝牙低耗能解决方案，CC2650 和

CC2640 是相同的。

就软件资源而言，需要以下工具：

• BLE-Stack [7]

• IAR EWARM v.7.70.2（或更高版本） [8]

或

• CCS 集成开发环境 [9]

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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4.2 嵌嵌入入式式软软件件

BLE-Stack 是用于德州仪器 (TI) 提供的 CC26xx 蓝牙低耗能器件的软件开发套件 (SDK)。该软件包包含完整

的蓝牙低耗能 (BT4.2) 协议堆栈以及样例 应用。软件堆栈作为预认证的库组件提供，引入具有完整电源管理

功能的线程环境的 RTOS 可操作这整个系统。电源管理由 RTOS 自动维护，应用则可以根据需要限制任务

或禁止使用某些功耗模式。表 4 显式了这些功耗模式。

表表 4. CC2650 功功耗耗模模式式

功功耗耗模模式式 说说明明 电电流流

工作 系统 CPU 正在运行 1.45mA +
31µA/MHz

空闲 CPU 所在的电源域处于关闭状态 550uA
待机 CPU 所在的电压域处于关闭状态 1uA
关断 仅 IO 保持运行。所有电压稳压器、电压和电源域都处于关闭状态 0.1uA

包含在 BLE-Stack 中的通用样例应用 simple_peripheral 非常适合用于分析单独运行在无线 MCU 上的蓝牙

低耗能协议的功耗。要获取纯粹的蓝牙低耗能协议分析，需要按照表 5 中所述在 simple_peripheral 样例应

用中进行一些修改。之所以需要进行修改，是因为我们的目的是测量 BLE 堆栈单独产生的电流消耗，因此

必须关闭额外的应用处理。进行板初始化之后，GPIO 引脚默认情况下已处于功耗优化状态。不过，如果您

使用 CC2650LP 或 CC2640R2LP，则需要关闭外部闪存，因为它默认情况下处于启用状态。

表表 5. SimpleBLEPeripheral 需需要要的的软软件件修修改改

功功能能 说说明明

周期性事件 发生的唯一应用处理是在建立连接后开始的周期性事件。要从应用中清除周期性事件，只需注释掉
simple_peripheral.c 文件中 SimpleBLEPeripheral_processStateChangeEvt 函数的
GAPROLE_CONNECTED 用例中的以下源代码行：

//Util_startClock(&periodicClock);
注释掉该行之后，就绝不会再设置第一个周期性事件的 RTOS 计时器。

LCD 通过在预定义的符号中添加 Display_DISABLE_ALL 来禁用所有屏幕。在 CCS 中，转到“Project
Properties”→“Build”→“ARM Compile”→“Advanced Options”→“Predefined Symbols”→“Pre-define
NAME”。在 IAR 中，转到“Project Options”→“C/C++ Compiler”→“Preprocessor”→“Defined symbols”。

连接参数更新 在建立连接后不久，会从外围器件发出自动连接参数请求。它使用 simple_peripheral.c 中定义的参数。在
执行测量任务时，删除该功能并通过对等器件直接控制连接参数会更加便利。

在 simple_peripheral.c 中，将 DEFAULT_ENABLE_UPDATE_REQUEST define 更改为 GAPROLE_
LINK_PARAM_UPDATE_WAIT_REMOTE_PARAMS，如下所示：

#define DEFAULT_ENABLE_UPDATE_REQUEST
GAPROLE_LINK_PARAM_UPDATE_WAIT_REMOTE_PARAMS

[仅限 CC2650LP/CC2640R2LP]
添加 ExtFlash.c 和 ExtFlash.h

ExtFlash.c 和 ExtFlash.h 位于 TI-RTOS 中间件中（对于 CC2650LP，文件位于 C:\ti\tirtos_cc13xx_
cc26xx_2_18_00_03\products\tidrivers_cc13xx_cc26xx_2_16_01_13\packages\ti\mw\extflash\ 下。对于
CC2640R2LP，文件位于 C:\ti\simplelink_cc2640r2_sdk_1_00_00_22\source\ti\mw\extflash 下）。通过
转到“Project”→“Add Files”（仅在“CCS Edit”视图中可行，在“CCS Debug”视图中不可行）将其添加到
SBP 应用项目中。此外，使用以下命令将其包含在 simple_peripheral.c 中：
#include <ti/mw/extflash/ExtFlash.h>

[仅限 CC2650LP/CC2640R2LP]
关闭外部闪存

通过调用 打开和关闭外部闪存
ExtFlash_open();
ExtFlash_close();

（在
SimpleBLEPeripheral_init().

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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有关更多信息（包括有关如何对 CC2650、CC2640 和 CC2640R2F 进行编程的说明），请参阅软件开发指

南 [1]。

4.3 硬硬件件

4.3.1 SmartRF06

SmartRF06 板包含许多外设 功能。要获取不受干扰的测量结果，务必拆除表 6 中所示的几根跳线；图 4 显

示了其目视位置。如果未拆除这些跳线，则会产生额外的电流消耗。

表表 6. SmartRF06 跳跳线线拆拆除除

功功能能 SmartRF06 上上的的跳跳线线 备备注注

JTAG P408 请注意，这会禁用 JTAG，这意味着编程和调试功能将变得不可用。

EM GPIO P403、P404 和 P405 并非所有跳线都需要拆除，但为了简单起见，最好将其全部拆除。

UART J5 UART 启用

图图 4. SmartRF06 板板跳跳线线拆拆除除

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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确保仔细检查 EM 是否需要天线或者它是否正在使用 PCB 天线。可通过观察 EM 上的 R10/R11 来对此进

行验证，如图 5 所示。

图图 5. CC2650EM 天天线线选选项项

注注: 在 SmartRF06 v121 和更旧的版本中，R502 旁边安装了一个小型运算放大器。在这种情况
下，请将其拆除，否则在测量期间它会增加功耗。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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4.3.2 CC2650/CC2640R2 LaunchPad

要获取不受干扰的电流测量结果，应拆除 CC2650LP 和 CC2640R2LP 上的跳线。图 6 显示了已拆除所有

跳线的 Launchpad。请注意，拆除 JTAG 跳线后，芯片的编程和调试功能将变得不可用。

图图 6. CC2650 LaunchPad 跳跳线线拆拆除除

图 6 适用于拥有 CC2640R2 LP 的用户。

4.4 BTool（（可可选选））

BLE-Stack 还包含 BTool 以及驱动程序和固件。BTool 可用于从 PC 环境中对蓝牙低耗能应用进行仿真。

BTool 用于创建与 DUT 的连接，如果目的是测量处于通告或信标模式的 DUT 的功耗，则不需要 BTool。

要使用 BTool 连接 DUT，需要使用一个运行名为 HostTest 的蓝牙低耗能无线网络处理器映像的器件。可以

在 BLE-Stack 中的另一个示例项目中找到它。

如果您要在 CC2540 USB 软件狗上运行 HostTest，则可以在 1.4 BLE-Stack 的默认安装目录中找到相应的

固件映像 (\Accessories\HexFiles\CC2540_USBdongle_HostTestRelease_All.hex)。（它也与 Device
Monitor 安装程序 (http://processors.wiki.ti.com/index.php/BLE_Device_Monitor_User_Guide) 捆绑在一起。

要对 CC2540USB 软件狗进行编程，请使用 SmartRF 闪存编程器 1 (http://www.ti.com.cn/tool/cn/flash-
programmer)。如果 CC2540 USB 软件狗运行的是正确的固件，则它上面的 LED 应呈红色亮起。（如果

CC2540 USB 软件狗的 CDC 驱动程序未自动安装，它位于 1.4 BLE-Stack 的默认安装目录中

(\Accessories\Drivers)）。

在软件狗连接到 PC 的情况下，打开 BTool。选择 HostTest 器件已连接到的正确 COM 端口。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
http://processors.wiki.ti.com/index.php/BLE_Device_Monitor_User_Guide
http://www.ti.com.cn/tool/cn/flash-programmer
http://www.ti.com.cn/tool/cn/flash-programmer
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图图 7. BTool 串串行行端端口口设设置置

按“OK”，然后应执行初始化过程，可以在日志窗口中观察到该过程。

在形成连接之前，应使用正确的连接参数。这将取决于所考虑的应用。监控超时设置不应影响功率测量。在

本文档中将使用 1 秒的连接间隔和零从设备延迟。因此，使用图 8 所示的值。确保在输入这些值后选择

“Set”按钮。在建立连接之前，需要完成连接参数设置。

图图 8. BTool 连连接接设设置置

根据需要设置连接参数后，设置就完成了。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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此时，BTool 可以发现 DUT 了。如果您让 SimpleBLEPeripheral 应用在 DUT 上运行，则应该已准备好使用

BTool。只要运行 SimpleBLEPeripheral 的器件已通电并且未进行任何连接，则应处于可发现（通告）模

式。

在“Discovery”部分中，按“Scan”按钮，如图 9 所示。

图图 9. BTool 扫扫描描

BTool 将开始搜索蓝牙低耗能器件。几秒钟之后，器件发现过程将结束。或者，如果您不希望在整个扫描期

间（持续 10 秒钟）一直等待，则可以按“Cancel”按钮，这将停止器件发现过程。扫描到的任何器件的地址

都将显示在“Slave BDA”部分，如图 10 所示。

图图 10. BTool 扫扫描描结结果果

要与外围设备建立连接，请选择要连接的设备的地址，然后单击“Establish”按钮，如图 11 所示。

图图 11. BTool 建建立立链链路路

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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只要外设已通电并且仍处于可发现模式，应该就可以立即建立连接。建立连接后，消息窗口将返回“GAP_
EstablishLink”事件消息以及“Status”值“0x00 (Success)”。在 BTool 中，您可以在“Device Information”字段

中看到已连接的外围设备，如图 12 所示。

图图 12. BTool 已已连连接接的的设设备备

5 使使用用直直流流电电源源分分析析仪仪测测量量功功耗耗

测量功耗的最简单方法是利用直流电源分析仪，它比简单的万用表先进很多。由于功耗随时间推移而变化，

因此简单的万用表无论如何都无法完全满足需求。也可以使用示波器，但是采样率和带宽必须足够好。本应

用报告中使用的是 Agilent N6705B 直流电源分析仪（请参阅图 13）。内部模块是 N6781A，它是一个用于

电池耗电分析的 2 象限电源和测量单元。

图图 13. Agilent N6705B 直直流流电电源源分分析析仪仪

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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5.1 测测试试设设置置

确保正确设置系统并查看4 节中所述的步骤。图 14 展示了完整的概图，以供参考。请注意，VDD 连接至

SmartRF06 上称为“VDD TO EM”的引脚。对于 CC2650LP 和 CC2640R2LP，将 VDD 连接至 3V3 引脚。

正确连接 DUT 之后，通过按 Agilent 14585A 控制和分析软件内的“On”按钮启用电源。可以通过两个独立的

功能完成功耗测量：Scope 或 Data Logger。Data Logger 提供较长时间内的平均功耗测量（例如几分钟或

几个小时），但分辨率不像使用 Scope 那么好。本文档着重介绍如何使用“Scope”功能进行测量。

图图 14. DUT 测测试试设设置置

Agilent N6705B 为 DUT 供电并执行电流测量。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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5.1.1 分分析析软软件件设设置置

可以直接使用 Agilent N6705B 接口执行所有测量和分析，但在本应用报告中使用了一个 PC 工具来控制

Agilent N6705B。用于控制 Agilent N6705B 的 PC 软件是“Agilent 14585A 控制和分析软件”v2.0.2.1。可以

在 http://www.keysight.com/（2014 年，Keysight Technologies 收购了 Agilent 电子仪器部门）下载全部软

件。

启动 PC 工具后，未连接任何外部设备，可以在“Instrument Control”选项卡中进行观察，如图 15 所示。

图图 15. Agilent 14585A 控控制制和和分分析析软软件件：：启启动动

要连接 Agilent N6705B，请确保通过 USB 对其进行连接并对其通电。使用左下角的“Connect”按钮选择连接

的硬件，如图 16 所示。

图图 16. Agilent 14585A 控控制制和和分分析析软软件件：：连连接接

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
http://www.keysight.com/
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成功连接硬件后，便可通过 PC 工具对其进行全面控制，您可以通过“Instrument Control”选项卡验证该情

况，如图 17 所示。

图图 17. Agilent 14585A 控控制制和和分分析析软软件件：：已已连连接接

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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请注意，默认情况下输出可能处于“On”状态（可以通过点亮的“On”按钮进行观察）。如果是这样，则将输出

关闭，因为尚未配置实际的输出参数。下一步是配置输出。在“Instrument Control”选项卡中，单击“Settings”
按钮以显示“Output 1”的“Source Settings”。这些选项可能会受到限制，具体取决于 Agilent N6705B 中的模

块。选择“2 Quadrant Power Supply”并将“Voltage”设置为 3V。

图图 18. Agilent 14585A 控控制制和和分分析析软软件件：：电电源源设设置置

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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将仪器探头连接到 DUT。对于 SmartRF 板，VDD 线路连接到“VDD TO EM”引脚。GND 最容易连接到

SmartRF06 板的接地平面（请参阅图 19）。

对于 CC2650/CC2640R2 LaunchPad，应将 VDD 线路连接到 3V3 引脚。可以将 GND 连接到

CC2650/CC2640R2 LP 上的任何接地引脚。图 20 显示了如何连接到 CC2650/CC2640R2 LP。

图图 19. 将将 SmartRF06 评评估估板板连连接接到到 Agilent 14585A

图图 20. 连连接接 CC2650/CC2640R2 LaunchPad

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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正确连接 DUT 之后，通过按 Agilent 14585A 控制和分析软件内的“On”按钮启用电源。可以通过两个独立的

功能完成功耗测量：Scope 或 Data Logger。Data Logger 提供较长时间内的平均功耗测量（例如几分钟或

几个小时），但分辨率不像使用 Scope 那么好。本文档着重介绍如何使用“Scope”功能进行测量。

图图 21. 已已将将 DUT 连连接接到到 Agilent 14585A

5.2 使使用用“Scope”进进行行测测量量

正确设置和配置仪器后，确保选择“Scope”，如图 22 所示。

图图 22. Agilent 14585A 控控制制和和分分析析软软件件：：“Scope”

“Scope”模式允许在短时间内运行测量。为了实现最大的数据量，应设置以下参数（请参阅图 23）。

• Resolution：200ms/div

• Points：512k

• Trigger：Scope Run Button

• Mode：Single

• Slope：Rising Edge

图图 23. Agilent 14585A 控控制制和和分分析析软软件件：：“Scope”设设置置

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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接下来，确保将“Ranges…”设置为“Auto”，如图 24 所示。

图图 24. Agilent 14585A 控控制制和和分分析析软软件件：：仪仪器器范范围围

现在应该已正确设置仪器，可以开始测量了。单击右下角的“Play”按钮 → 允许仪器开始测量。

5.3 分分析析

根据设置 DUT 所执行的操作，结果会有所不同。如果没有与 DUT 进行交互，它将每 100ms 发送一次周期

性通告。

图图 25. Agilent 14585A 控控制制和和分分析析软软件件：：通通告告捕捕捉捉

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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约 2.66s 的测量包含 26 个通告事件，在两个相邻通告事件之间处于待机状态，在这期间会出现一个再充电

脉冲。

该软件提供了一个用于对采集的波形进行详细测量的功能。选择“Markers & Measurements”可以启用标记，

标记可用于获取平均功耗。我们可通过两种方法使用标记：

• 通过测量的对称点（例如，从一个事件的开始到下一个事件的开始）测量平均功耗。由于重复发生的对

称性，该方法将提供随时间变化而产生的总体功耗的近似值。

• 将事件分解为可用于各种用例研究和估算的各种状态。当需要在间隔改变时分析产生的功耗时，这种方

法非常有用。

如果目标是仅获取 DUT 的功耗数据，则第一个选项快速且可靠。

5.3.1 通通告告事事件件

在通告事件中，（蓝牙低耗能）外围设备会广播信息以共享信息或连接到（蓝牙低耗能就绪）中心设备，如

智能手机。此时设备被唤醒，在三个独立的通道上广播数据包，并在其中的每个通道上侦听扫描请求或连接

请求。扫描请求是中心设备在连接之前获取有关该设备的更多信息的一种方法，因为选择的通告数据通常很

短，以将功耗降至最低。根据通告数据或扫描响应数据，可以发送连接请求，这将启动外围设备和中心设备

之间的连接。

采用可连接的通告数据包格式时，数据传输的基准时间为 144µs，其中包含有效负载中的 1 字节的前导码、

4 字节的访问地址、2 字节的 PDU、3 字节的 CRC 和 6 字节的 AdvA。对于每个额外的传输字节，应将 TX
时间增加 1µs。

Agilent 14585A 控制和分析软件“Markers & Measurements”功能用于量化单个通告事件，图 26 对其进行了

直观的显示，表 7 对其进行了总结。

图图 26. 可可连连接接的的通通告告事事件件：：捕捕捉捉

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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表表 7. 通通告告事事件件：：状状态态分分析析

状状态态 时时间间 [µs] 电电流流 [mA] 备备注注

1 预处理 1160 3.26 RTOS 唤醒、无线电设置、XTAL 保护时间

2 无线电准备 101 4.3 无线电已打开并且正在向 TX 状态过渡

3 TX 168 7.47 无线电在通道 37 上传输包含 3 字节数据的通告数据包。时间取决于传输的
数据量

4 从 TX 向 RX 过渡 112 4.66 从 TX 向 RX 过渡

5 RX 184 6.47 时间取决于通告间隔和 SCA
6 从 RX 向 TX 过渡 370 3.43 从 RX 向 TX 过渡

7 TX 168 7.47 无线电在通道 38 上传输包含 3 字节数据的通告数据包。时间取决于传输的
数据量

8 从 TX 向 RX 过渡 112 4.66 从 TX 向 RX 过渡

9 RX 184 6.47 时间取决于通告间隔和 SCA
10 从 RX 向 TX 过渡 370 3.43 从 RX 向 TX 过渡

11 TX 168 7.47 无线电在通道 39 上传输包含 3 字节数据的通告数据包。时间取决于传输的
数据量

12 从 TX 向 RX 过渡 112 4.66 从 TX 向 RX 过渡

13 RX 184 6.47 时间取决于通告间隔和 SCA
14 后处理并将进入待机状态 685 2.45 BLE 协议堆栈处理接收到的数据包并设置睡眠计时器，以便为下一个事件做

好准备。然后将进入待机状态

这也是在设备处于信标模式时发生的事件。对于不可连接的信标，在发生通告事件期间不存在 RX 状态，这

会进一步降低功耗。

图图 27. 信信标标事事件件：：捕捕捉捉

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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表表 8. 信信标标事事件件：：状状态态分分析析

状状态态 时时间间 [µs] 电电流流 [mA] 备备注注

1 预处理 1160 3.26 RTOS 唤醒、无线电设置、XTAL 保护时间

2 无线电准备 101 4.3 无线电已打开并且正在向 TX 状态过渡

3 TX 144 7.47 无线电在通道 37 上传输包含 3 字节数据的通告数据包。时间取决于传输的
数据量

4 TX 到 TX 过渡 372 3.56 TX 到 TX 过渡

5 TX 144 7.47 无线电在通道 38 上传输包含 3 字节数据的通告数据包。时间取决于传输的
数据量

6 TX 到 TX 过渡 372 3.56 TX 到 TX 过渡

7 TX 144 7.47 无线电在通道 39 上传输包含 3 字节数据的通告数据包。时间取决于传输的
数据量

8 后处理并将进入待机状态 685 2.45 BLE 协议堆栈设置睡眠计时器，以便为下一个事件做好准备。然后将进入待
机状态

5.3.2 待待机机

待机是通告（以及连接）事件之间的电源模式，其中包含 VDDR 再充电。再充电是待机期间强制执行的功

能，用于维持 RAM 并确保为时钟供电。这些再充电之间的功耗大约为 70nA，它太小以至于几乎测量不

到。被定义为待机电流的是待机期间的平均功耗（包含再充电），在 CC2640、CC2640R2F 和 CC2650 数

据手册中，该值大约为 1µA。此外，请注意，该数字不是固定的，因为再充电脉冲会根据要求的待机时间动

态调整。如果在复位 DUT 之后立即执行测量，则在通告和连接事件之间将存在更多的再充电，而在几秒钟

之后，再充电数量将降低至强制的 1 个事件。这意味着待机将从稍高的值降低至最佳值。曾测量到的较高的

值可达 2µA。

图图 28. VDDR 再再充充电电

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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当待机间隔较长时，再充电脉冲的数量将会稍微有所增加。例如，当 DUT 进入某个连接时，便会出现这种

情况。我们可以通过将标记放置在两个通告和连接事件之间来测量待机电流。在图 29 中，DUT 以 100ms
的间隔进行通告，在相邻通告事件之间存在一次再充电；在这种情况下，产生的待机电流为 1.57µA。以

100ms 的连接间隔进行通告时，待机电流不会低于该值。

图图 29. 在在通通告告期期间间测测量量待待机机电电流流

按照节 5.3.3中所述建立连接后，可以执行类似的测量，由于 1s 的长连接间隔（之间有两次再充电），可产

生 0.88µA 的最佳值。

图图 30. 在在连连接接期期间间测测量量待待机机电电流流

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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5.3.3 连连接接事事件件

在外围设备与中心设备之间建立连接时，它们会在连接事件期间进行通信。中心设备作为主设备运行，外围

设备作为从设备运行。

两个已连接的设备之间的所有通信均在这些连接事件上发生。它们以可配置的连接间隔（从 7.5ms 到 4
秒）周期性发生。

每个事件在 37 个数据通道中的某一个上发生，主设备始终启动事件，从设备进行侦听。在一个连接事件期

间，它们能够以所需的通信量持续地来回通信。

即使任一端都没有要发送的数据，也会发生连接事件。这可以确保链路仍然有效。如果指定数量的连接事件

在未确认的情况下发生，则连接被视为中断。

为了测量连接事件，必须将 DUT 连接到一个对等器件。通过按照4.4 节中的说明使用 BTool，建立连接间隔

为 1 秒的连接。

要测量平均功耗，最简单的方法是确定复发部分并测量该部分的平均电流。这将代表器件在该运行模式下的

平均功耗。对于某个连接，通过将一个标记刚好放置在一个连接事件之后（如图 31 中所示）并将第二个标

记放置在下一个连接事件之后（如图 32 中所示）来实现该方法。然后，可以在图 32 中观察到平均电流，

大约为 9.94µA。

图图 31. 连连接接事事件件：：第第 1 个个标标记记放放置置

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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图图 32. 连连接接事事件件：：第第 2 个个标标记记放放置置

还可以通过选择“Markers & Measurements”对连接事件进行量化，以全面分析各种状态，这与通告事件类

似，如图 33 和表 9 中所示。

图图 33. 单单个个连连接接事事件件期期间间的的电电流流消消耗耗与与时时间间

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/SWRA478.pdf
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表表 9. 连连接接事事件件：：状状态态分分析析

状状态态 时时间间 [µs] 电电流流 [mA] 备备注注

1 预处理 1165 3.22 RTOS 唤醒、无线电设置、XTAL 保护时间

2 无线电准备 132 3.99 无线电已打开并且正在转换为 RX
3 接收 (RX) 129 6.48 无线电接收器侦听来自主设备的数据包。时间取决于连接间隔和

SCA
4 从 RX 向 TX 过渡 149 5.49 从 RX 向 TX 过渡

5 发送 (TX) 90 7.66 无线电在 37 个通道中的某一个通道上向主设备传输一个数据
包。时间取决于传输的数据量

6 后处理并将进入待机状态 775 2.59 BLE 协议堆栈处理接收到的数据包并设置睡眠计时器，以便为下
一个事件做好准备。然后将进入待机状态

5.3.4 功功耗耗计计算算

针对通告和连接状态进行的状态分析可用于调查电池寿命如何因连接间隔的不同而发生变化。为此，我们提

供了一个功耗计算工具，用于针对您的定制应用执行计算。

6 参参考考

1. 《CC2640 和 CC2650 SimpleLink™ Bluetooth® 低耗能软件堆栈 2.2.1 开发人员指南》(http:/
/www.ti.com/cn/lit/pdf/swru393)

2. 《CC13xx、CC26xx SimpleLink 无线 MCU 技术参考手册》(SWCU117)
3. 《CC2640 SimpleLink™ Bluetooth® 无线 MCU 数据手册》(SWRS176)
4. 《CC2640R2F SimpleLink™ Bluetooth® 低耗能无线 MCU 数据手册》(SWRS204)
5. 《CC2650 SimpleLink™ 多标准无线 MCU 数据手册》(SWRS158)
6. TI store：https://store.ti.com/
7. BLE-Stack™：www.ti.com/ble-stack
8. IAR Embedded Workbench™for ARM：http://www.iar.com/Products/IAR-Embedded-Workbench/ARM/
9. CCS 集成开发环境：(http://www.ti.com.cn/tool/cn/ccstudio)
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您只有在为开发包含该等 TI 资源所列 TI 产品的 应用时， 才被授权使用、复制和修改任何相关单项 TI 资源。但并未依据禁止反言原则或其他
法理授予您任何TI知识产权的任何其他明示或默示的许可，也未授予您 TI 或第三方的任何技术或知识产权的许可，该等产权包括但不限于任
何专利权、版权、屏蔽作品权或与使用TI产品或服务的任何整合、机器制作、流程相关的其他知识产权。涉及或参考了第三方产品或服务的信
息不构成使用此类产品或服务的许可或与其相关的保证或认可。使用 TI 资源可能需要您向第三方获得对该等第三方专利或其他知识产权的许
可。
TI 资源系“按原样”提供。TI 兹免除对 TI 资源及其使用作出所有其他明确或默认的保证或陈述，包括但不限于对准确性或完整性、产权保证、
无屡发故障保证，以及适销性、适合特定用途和不侵犯任何第三方知识产权的任何默认保证。
TI 不负责任何申索，包括但不限于因组合产品所致或与之有关的申索，也不为您辩护或赔偿，即使该等产品组合已列于 TI 资源或其他地方。
对因 TI 资源或其使用引起或与之有关的任何实际的、直接的、特殊的、附带的、间接的、惩罚性的、偶发的、从属或惩戒性损害赔偿，不管
TI 是否获悉可能会产生上述损害赔偿，TI 概不负责。
您同意向 TI 及其代表全额赔偿因您不遵守本通知条款和条件而引起的任何损害、费用、损失和/或责任。
本通知适用于 TI 资源。另有其他条款适用于某些类型的材料、TI 产品和服务的使用和采购。这些条款包括但不限于适用于 TI 的半导体产品
(http://www.ti.com/sc/docs/stdterms.htm)、评估模块和样品 (http://www.ti.com/sc/docs/sampterms.htm) 的标准条款。
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